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1 Overview of the Early Power Estimator for Intel® Cyclone® 10 LP

1 Overview of the Early Power Estimator for Intel®
Cyclone® 10 LP
This user guide describes the Early Power Estimator (EPE) support for Cyclone® 10 LP
devices. This user guide provides guidelines for using the EPE at any stage of the
FPGA design and provides details about thermal analysis and the factors contributing
to FPGA power consumption. You can calculate the FPGA power with the Microsoft
Excel-based EPE spreadsheet. For more accurate power estimation, use the Power
Analyzer in the Quartus® Prime software.
Intel recommends switching from the EPE spreadsheet to the Power Analyzer in the
Quartus Prime software once the design is available. The Power Analyzer has access to
the implemented design details to produce more accurate results.
Intel recommends using these calculations as an estimation of power, not as a
specification. You must verify the actual power during device operation as the
information is sensitive to the actual device design and the environmental operating
conditions.
The features of the EPE spreadsheet include:
•

Estimating the power consumption of your design before creating the design or
during the design process

•

Importing device resource information from the Quartus Prime software into the
EPE spreadsheet with the use of the Quartus Prime-generated EPE file

•

Performing preliminary thermal analysis of your design

1.1 Power Model Status
The power models in the Early Power Estimator (EPE) spreadsheet are in either
preliminary or final status. Preliminary power models are subject to change, and are
created based on simulation results, process data, and other known parameters. The
final power models are created based on a complete correlation to the production
device. If the power models are final, there are no further changes to the power
models. The power model status for the device is shown in the Main worksheet of the
EPE spreadsheet.
For the majority of the designs, the Power Analyzer and the EPE spreadsheet have the
following accuracy after the power models are final:
•

Power Analyzer: ± 20% from silicon, assuming that Power Analyzer uses the Value
Change Dump File (.vcd) generated toggle rates

•

EPE spreadsheet: ± 30% from silicon, assuming EPE data imported from Power
Analyzer results using .vcd generated toggle rates
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The toggle rates are derived using the Power Analyzer with a .vcd file generated from
a gate level simulation representative of the system operation.

1.2 Document Revision History
Table 1.

Document Revision History
Date

May 2017

Version
2017.05.08

Changes
•

Initial release.
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2 Setting Up the Early Power Estimator for Intel® Cyclone
10 LP

2.1 System Requirements
The Early Power Estimator for Cyclone 10 LP requires the following software:
•

Windows operating system

•

Microsoft Excel 2003, Microsoft Excel 2007, or Microsoft Excel 2010

•

Quartus Prime software version 17.0 or later (if generating a file for importation)

2.2 Download and Install the Early Power Estimator
The Early Power Estimator (EPE) spreadsheet for Intel® Cyclone 10 LP is available
from the Early Power Estimators (EPE) and Power Analyzer page on www.altera.com.
After reading the terms and conditions and clicking I Agree, you can download the
Microsoft Excel (.xls or .xlsx) file.
By default, the macro security level in Microsoft Excel 2003, Microsoft Excel 2007, and
Microsoft Excel 2010 is set to High. If the macro security level is set to High, macros
are automatically disabled. For the features in the Early Power Estimator spreadsheet
to function properly, you must enable macros.

2.2.1 Changing the Macro Security Level in Microsoft Excel* 2003
To change the macro security level in Microsoft Excel* 2003, follow these steps:
1.

Click Tools ➤ Options.

2. Click Security ➤ Macro Security.
3.

Select Security Level ➤ Medium in the Security dialog box then click Ok.

4. Click Ok in the Options window.
5. Close the Early Power Estimator spreadsheet and reopen it.
6. Click Enable Macros in the pop-up window.
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2.2.2 Changing the Macro Security Level in Microsoft Excel* 2007

To change the macro security level in Microsoft Excel* 2007, follow these steps:
1.

Click the Office button in the upper left corner of the .xlsx file.

2.

Click the Excel Options button at the bottom of the menu.

3.

Click the Trust Center button on the left. Then, click the Trust Center Settings
button.

4. Click the Macro Settings button in the Trust Center dialog box. Turn on the
Disable all macros with notification option.
5.

Close the Early Power Estimator spreadsheet and reopen it.

6. Click Options when a security warning appears beneath the Office ribbon.
7.

Turn on Enable this content in the Microsoft Office* Security Options dialog
box.

2.2.3 Changing the Macro Security Level in Microsoft Excel* 2010

To change the macro security level in Microsoft Excel 2010, follow these steps:
1.

Click File

2. Click Help ➤ Options
3. Click Trust Center ➤ Trust Center Settings
4. Click the Macro Settings button in the Trust Center dialog box. Turn on the
Disable all macros with notification option.
5. Close the Early Power Estimator spreadsheet and reopen it.
6. Click Enable Content when a security warning appears beneath the Office ribbon.

2.3 Estimating Power Consumption
With the Early Power Estimator, you can estimate power consumption at any point in
your design cycle. You can use the EPE to estimate the power consumption when you
have not yet begun your design, or if your design is partially complete. Although the
EPE can provide a power estimate for your completed design, Intel recommends that
you use the Power Analyzer in the Quartus Prime software instead, for a more
accurate estimate based on the exact placement and routing information of the
completed design.

2.3.1 Estimating Power Consumption Before Starting the FPGA Design

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
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Table 2.

Advantage and Constraints of Power Estimation before Designing FPGA
Advantage

Constraint

You can obtain power estimation before starting your FPGA
design.

•

•

Accuracy depends on your inputs and your estimation of
the device resources; where this information may
change (during or after your design is complete), your
power estimation results may be less accurate.
The Early Power Estimator (EPE) spreadsheet uses
averages and not the actual design implementation
details; for example ALUT input usage and routing. The
Power Analyzer has access to the full design details.

To estimate power consumption with the EPE spreadsheet before starting your FPGA
design, follow these steps:
1.

On the Main worksheet of the EPE spreadsheet, select the target family, device,
and package from the Family, Device, and Package drop-down list.

2.

Enter values for each worksheet in the EPE spreadsheet. Different worksheets in
the EPE spreadsheet display different power sections, such as clocks and phaselocked loops (PLLs).

3.

The calculator displays the total estimated power consumption in the Total FPGA
and Total SoC (if applicable) cells of the Main worksheet.

2.3.1.1 Entering Information into the Early Power Estimator
You can either enter power information into the Early Power Estimator (EPE)
spreadsheet manually or load an EPE file generated by the Quartus Prime software.
You can also clear all current values in the EPE spreadsheet by clicking the Reset
button on the Main worksheet.
To use the EPE spreadsheet, enter the device resources, operating frequency, toggle
rates, and other parameters in the EPE spreadsheet. If you do not have an existing
design, you must estimate the number of device resources your design uses and enter
the information into the EPE spreadsheet.

2.3.1.2 Manually Entering Values
You can manually enter values into the Early Power Estimator (EPE) spreadsheet in the
appropriate section. White unshaded cells are input cells that you can modify. Each
section contains a column that allows you to specify a module name based on your
design.

2.3.2 Estimating Power Consumption While Creating the FPGA Design
If your FPGA design is partially complete, you can import the Early Power Estimator
(EPE) file (<revision name>_early_pwr.csv) generated by the Quartus Prime
software to the EPE spreadsheet. After importing the information from the <revision
name>_early_pwr.csv into the EPE spreadsheet, you can edit the EPE spreadsheet
to reflect the device resource estimates for your final design.

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
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Table 3.

Advantages and Constraints of Power Estimation if your FPGA Design is
Partially Complete
Advantage

•
•

You can perform power estimation early in the FPGA
design cycle.
Provides the flexibility to automatically fill in the Early
Power Estimator spreadsheet based on the Quartus
Prime software compilation results.

Constraint
•

•

Accuracy depends on your inputs and your estimation of
the device resources; where this information may
change (during or after your design is complete), your
power estimation results may be less accurate.
The EPE spreadsheet uses averages and not the actual
design implementation details; for example ALUT input
usage and routing. The Power Analyzer has access to the
full design details.

2.3.2.1 Importing a File
To estimate power consumption with the Early Power Estimator (EPE) spreadsheet if
your FPGA design is partially complete, you can import a file.
By importing a file, you can save time and effort otherwise spent on manually entering
information into the EPE. You can also change any of the values manually after
importing a file.

2.3.2.2 Generating the Early Power Estimator (EPE) File
To generate the Early Power Estimator (EPE) file, follow these steps:
1. Compile the partial FPGA design in the Quartus Prime software.
2. On the Project menu, click Generate Early Power Estimator File to generate
the <revision name>_early_pwr.csv in the Quartus Prime software.

2.3.2.3 Importing Data into the Early Power Estimator (EPE) Spreadsheet
You must import the Early Power Estimator (EPE) file into the EPE spreadsheet before
modifying any information in the EPE spreadsheet. Also, you must verify all your
information after importing a file.
Importing a file from the Quartus Prime software populates all input values on the
Main worksheet that were specified in the Quartus Prime software. These parameters
include:
•

Family

•

Device

•

Package

•

Temperature grade

•

Power characteristics

•

Core voltage (V)

•

Ambient (TA) or junction (TJ) temperature (°C)

•

Heat sink

•

Airflow

•

Custom θSA or Custom θJA

•

Board thermal model

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
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The ambient or junction temperature, heat sink, airflow, Custom θSA or Custom θJA,
and board thermal model parameters are optional. For more information about these
parameters, refer to the Main worksheet.
The clock frequency (fMAX) values imported into the EPE spreadsheet are the same as
the fMAX values taken from the Quartus Prime software as per the design. You can
manually edit the fMAX values and the toggle percentage in the EPE spreadsheet to suit
your design requirements.
To import data into the EPE spreadsheet, follow these steps:
1.

In the EPE spreadsheet, Click Import CSV.

2.

Browse to a EPE file generated from the Quartus Prime software and click Open.
The file has a name of <revision name>_early_pwr.csv.

3.

In the confirmation window to proceed, click OK.

4. If the file is imported, click OK. Clicking OK acknowledges the import is complete.
If there are any errors during the import, an .err file is generated with details.

2.3.3 Estimating Power Consumption After Completing the FPGA Design
If your design is complete, Intel strongly recommends using the Power Analyzer in the
Quartus Prime software.
The Power Analyzer provides the most accurate estimate of device power
consumption. To determine power consumption, the Power Analyzer uses simulation,
user mode, and default toggle rate assignments, in addition to placement-and-routing
information.

2.4 Document Revision History
Table 4.

Document Revision History
Date

May 2017

Version
2017.05.08

Changes
•

Initial release.
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3 Early Power Estimator Worksheets for Intel Cyclone 10
LP
This chapter provides information about each worksheet of the early Power Estimator
(EPE) spreadsheet.
The EPE spreadsheet lets you enter information into worksheets based on architectural
features. The EPE spreadsheet also provides a subtotal of power consumed by each
architectural feature, reported in each worksheet in watts. For more information about
each architectural feature refer to the respective worksheets.

3.1 Cyclone 10 LP EPE - Main Worksheet
The Main worksheet of the Early Power Estimator (EPE) spreadsheet summarizes the
power and current estimates for the design. The Main worksheet displays the total
thermal power, thermal analysis, and power supply sizing information.
Figure 1.

Main Worksheet of the EPE Spreadsheet

The Export CSV feature provides a lightweight export file as compared to the EPE file.
The generated .csv file has a similar file format to the EPE spreadsheet. The following
sections describe the sections in the EPE Main worksheet.
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3.1.1 Input Parameters
The required parameters depend on whether you enter the junction temperature
manually, or have it computed automatically.
Table 5.

Input Parameter Section Information
Input Parameter

Description

Family

Select the device family.

Device

Select your device.
Larger devices consume more static power and have higher clock dynamic
power. All other power components are unaffected by the device used.

Package

Select the package that is used.
Larger packages provide a larger cooling surface and more contact points to
the circuit board, leading to lower thermal resistance. Package selection
does not affect dynamic power.

Temperature Grade

Select the appropriate temperature grade. This field affects the allowed
maximum junction temperature range. This field can also be used to
determine core voltage for some device families.
Different device families support different temperature grades. For more
information about the supported temperature grade and the recommended
operating range for the device junction temperature, refer to the respective
device family datasheet.

Power Characteristic

Select typical or theoretical worst-case silicon process.
There is a process variation from die-to-die. This primarily impacts the
static power consumption. Typical power characteristic provides results
that line up with average device measurements.
Maximum power characteristic provides results that line up with worstcase device measurements. To ensure your power supply design is sufficient
to handle the worst-case process variation that affects static power
consumption, Intel recommends using the Maximum power characteristic
for your power estimation. To enable the Enpirion device selection, you
must set Power Characteristics to Maximum.

VCCINT Voltage (V)

For Cyclone 10 LP devices, select the following VCCINT voltage:
• For devices with speed grade I8, set the VCCINT to 1.0V.
• For devices with speed grade C6, C7, C8, I7 and A7, set the VCCINT to
1.2V.

Power Model Status

This shows if the power model for the device is in preliminary or final
version and is only available from EPE 14.0 onwards.

Junction Temp, TJ (°C)

Enter the junction temperature of the device. This field is only available if
you turn on the User Entered T option. In this case, the junction
temperature is not calculated based on the thermal information provided.
For Enpirion power device selection, Intel recommends setting Junction
Temp, T (°C) to the highest value for the chosen temperature grade.

Ambient Temp, TA (°C)

Enter the air temperature near the device. This value can range from –
40°C to 125°C. This field is only available when you turn on the Auto
Computed T option.
If you turn on the Estimated Theta J option, this field is used to compute
the junction temperature based on power dissipation and thermal
resistance through the top-side cooling solution (heat sink or none) and
board (if applicable).
If you turn on the Custom Theta J option, this field is used to compute
junction temperature based on power dissipation and custom θJA entered.
continued...
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Input Parameter

Description

Heat Sink

Select the heat sink that is used. You can select one of the following:
• No heat sink (None)
• A custom solution (Custom)
• A heat sink with set parameters (15 mm–Low Profile, 23 mm–
Medium Profile, or 28 mm–High Profile). This field is only available if
you turn on the Auto Computed T and Estimated Theta J options.
If you select None, the heat sink selection updates the custom θSA value
and you can see the value in the Custom θSA (°C/W) parameter. If you
select Custom, the value is what is entered in the Custom θSA (°C/W)
parameter.
Representative examples of heat sinks are provided. Larger heat sinks
provide lower thermal resistance and lower the junction temperature. If the
heat sink is known, consult the heat sink datasheet and enter a custom θSA
value according to the airflow in your system.

Airflow

Select an available ambient airflow in linear-feet per minute (lfm) or meters
per second (m/s). The values are 100 lfm (0.5 m/s), 200 lfm (1.0
m/s), 400 lfm (2.0 m/s), or Still Air. This field is only available if you
turn on the Auto Computed T and Estimated Theta J options.
Increased airflow results in a lower case-to-air thermal resistance and
lowers the junction temperature.

Custom θJA (°C/W)

Enter the junction-to-ambient thermal resistance between the device and
ambient air (in °C/W). This field is only available if you turn on the following
options:
• Auto Computed T
• Estimated Theta J
• Set the Heat Sink parameter to Custom
To compute the overall junction-to-ambient resistance through the top of
the device, the Custom θSA parameter is combined with a representative
case-to-heatsink resistance and an Intel-provided junction-to-case thermal
resistance.

Board Thermal Model

Select the type of board that is used in the thermal analysis. The value is
None (Conservative), or JEDEC (2s2p). This field is only available if you
turn on the Auto Computed T and Estimated Theta J options.
If you select None (Conservative), the thermal model assumes no heat is
dissipated through the board, resulting in a pessimistic calculated junction
temperature. This option is not available if the Heat Sink option is set to
None.
If you select JEDEC (2s2p), the thermal model assumes the characteristics
of the JEDEC 2s2p test board specified in standard JESDEC51–9.
To determine the final junction temperature, Intel recommends performing
a detailed thermal simulation of your system. This two-resistor thermal
model is only for early estimation.

3.1.2 Thermal Power
Thermal power is the power dissipated in the FPGA device. Total thermal power is a
sum of the thermal power of all the resources used in the device, including the
maximum power from standby and dynamic power.
Total thermal power includes only the thermal component for the I/O section and does
not include the external power dissipation, such as from voltage-referenced
termination resistors.
The static power (PSTATIC) is the thermal power dissipated on chip, independent of user
clocks. PSTATIC includes the leakage power from all FPGA functional blocks, except for
I/O DC bias power and transceiver DC bias power, which are accounted for in the I/O
and transceiver sections.

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
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PSTATIC is the only thermal power component which varies with junction temperature,
selected device, and power characteristics (process).
The following figure shows the total thermal power (W) and PSTATIC consumed by the
FPGA. The thermal power for each worksheet is displayed. To see how the thermal
power for a worksheet was calculated, click on the button to view the selected
worksheet.
Figure 2.

Thermal Power Section in the Main Worksheet

Table 6.

Thermal Power Section Information
Column Heading

Description

Logic

This value shows the dynamic power consumed by adaptive logic modules (ALMs) and
associated routing. To view details, click the Logic button.

RAM

This value shows the dynamic power consumed by RAM blocks and associated routing.
To view details, click the RAM button.

DSP

This value shows the dynamic power consumed by digital signal processing (DSP)
blocks and associated routing. To view details, click the DSP button.

I/O

This value shows the thermal power consumed by I/O pins and associated routing. To
view details, click the I/O button.

PLL

This value shows the dynamic power consumed by phase-locked loops (PLLs). To view
details, click the PLL button.

Clock

This value shows the dynamic power consumed by clock networks. To view details,
click the Clock button.

PSTATIC

This shows the thermal power dissipated on chip, independent of user clocks. This
includes the leakage power from all FPGA functional blocks, except for I/O DC bias
power and transceiver DC bias power.
PSTATIC is affected by junction temperature, selected device, and power characteristics.

Total FPGA

This shows the total power dissipated as heat from the FPGA. This does not include
power dissipated in off-chip termination resistors.

3.1.3 Power Tree Design
The Power Tree Design section provides the current and voltage from the report page.
The power supply grouping is according to the device pin connection guidelines.

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
13

3 Early Power Estimator Worksheets for Intel Cyclone 10 LP

Figure 3.

Power Tree Design Section in the Main Worksheet

Select a valid configuration from the Power Rail Configuration dropdown. When the
Input Parameters and Power Rail Configuration selections are complete, the
power regulator selection will be enabled.
The current values shown for each regulator include the margin for regulator selection
purpose. For more information, refer to the Enpirion worksheet.
Errors regarding improper rail grouping may appear in the error window on the Main
worksheet when the Power Rail Configuration is selected. The following figure shows
an example of the error message in the error window.
Figure 4.

Error Window in the Main Worksheet

This occurs when the EPE assigns rails with different voltage requirements to the same
group. Since each group is supplied by a single regulator, these errors must be
corrected before the EPE can make proper component selections. This is done in the
EPE Report worksheet. Refer to the Report worksheet on how to correct the error.

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
14

3 Early Power Estimator Worksheets for Intel Cyclone 10 LP

3.1.4 Thermal Analysis
The following figure shows the Thermal Analysis section in the Main worksheet,
including the junction temperature (TJ), total junction-to-ambient thermal resistance
(θJA), and the maximum allowed ambient temperature (TA) values. For details about
the values of the thermal parameters not listed in this user guide, click the Details
button.
Figure 5.

Thermal Analysis Section of the Early Power Estimator Spreadsheet

Table 7.

Thermal Analysis Section Information
Column Heading

Description

Junction Temp, TJ (°C)

The device junction temperature estimation based on supplied thermal
parameters.
The junction temperature is determined by dissipating the total
thermal power through the top of the chip and through the board (if
selected). For detailed calculations, click the Details button.

θJA Junction-Ambient

The junction-to-ambient thermal resistance between the device and
ambient air (in °C/W).
Represents the increase in temperature between ambient and junction
for every W of additional power dissipation.

Maximum Allowed TA (°C)

A guideline for the maximum ambient temperature (in °C) that you can
subject the device to without violating the maximum junction
temperature, based on the supplied cooling solution and device
temperature grade.

You can directly enter or automatically compute the junction temperature based on
the information provided. To enter the junction temperature, select User Entered T in
the Input Parameters section. To automatically compute the junction temperature,
select Auto Computed T in the Input Parameters section.
When automatically computing the junction temperature, the ambient temperature,
airflow, heat sink solution, and board thermal model of the device determine the
junction temperature in °C. Junction temperature is the estimated operating junction
temperature based on your device and thermal conditions.
You can consider the device as a heat source and the junction temperature is the
temperature of the device. While the temperature typically varies across the device, to
simplify the analysis, you can assume that the temperature of the device is constant
regardless of where it is measured.

Early Power Estimator for Intel® Cyclone® 10 LP FPGAs User Guide
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Power from the device can be dissipated through different paths, which can become
significant depending on the thermal properties of the system. The significance of
power dissipation paths vary depending on whether the device uses a heat sink.

3.1.4.1 Not Using a Heat Sink
When you do not use a heat sink, the major paths of power dissipation are from the
device to the air. You can refer this as a junction-to-ambient thermal resistance.In this
case, there are two significant junction-to-ambient thermal resistance paths:

Figure 6.

•

From the device through the case to the air

•

From the device through the board to the air

Thermal Representation without a Heat Sink

θJA

Case
Device
Board

Thermal Representation without Heat Sink
In the model used in the Early Power Estimator (EPE) spreadsheet, power is dissipated
through the case and board. The θJA values are calculated for differing air flow options
accounting for the paths through the case and through the board.
Figure 7.

Thermal Model in the EPE Spreadsheet without a Heat Sink

Power (P)

TJ
θJA

Heat
Source

TA

The ambient temperature does not change, but the junction temperature changes
depending on the thermal properties; therefore the junction temperature calculation is
an iterative process.
The following equation shows the total power calculated based on the total θJA value,
ambient, and junction temperatures.
Figure 8.

Total Power
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3.1.4.2 Using a Heat Sink
When your device employs a heat sink, the major paths of power dissipation are from
the device through the case, thermal interface material, and heat sink. There is also a
path of power dissipation through the board. The path through the board has less
impact than the path to air.
Figure 9.

Thermal Representation with a Heat Sink

Heat Sink
Thermal interface material

θSA

θJC
Case
Device

θCS

Board
θJA BOTTOM
Thermal Representation with Heat Sink
In the model used in the Early Power Estimator (EPE) spreadsheet, power is dissipated
through the board or through the case and heat sink. The junction-to-board thermal
resistance (θJA BOTTOM) refers to the thermal resistance of the path through the board.
Junction-to-ambient thermal resistance (θJA TOP) refers to the thermal resistance of the
path through the case, thermal interface material, and heat sink.
Figure 10.

Thermal Model for the EPE Spreadsheet with a Heat Sink
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If you want the EPE spreadsheet thermal model to take the θJA BOTTOM into
consideration, set the Board Thermal Model parameter to JEDEC (2s2p). Otherwise,
set the Board Thermal Model parameter to None (conservative). In this case, the
path through the board is not considered for power dissipation and a more
conservative thermal power estimate is obtained.
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The addition of the junction-to-case thermal resistance (θJC), the case-to-heat sink
thermal resistance (θCS) and the heat sink-to-ambient thermal resistance (θSA)
determines the θJA TOP.
Figure 11.

Junction-to-Ambient Thermal Resistance

θJA TOP = θJC+ θCS + θSA
Based on the device, package, airflow, and heat sink solution selected in the Input
Parameters section, the EPE spreadsheet determines the θJA TOP.
If you use a low, medium, or high profile heat sink, select the airflow from the values
of Still Air and air flow rates of 100 lfm (0.5 m/s), 200 lfm (1.0 m/s), and 400
lfm (2.0 m/s). If you use a custom heat sink, enter the custom θSA value. You must
incorporate the airflow into the custom θSA value. Therefore, the Airflow parameter is
not applicable in this case. You can obtain these values from the heat sink
manufacturer.
The ambient temperature does not change, but the junction temperature changes
depending on the thermal properties. Because a change in junction temperature
affects the thermal device properties that are used to calculate junction temperature,
calculating the junction temperature is an iterative process.
The total power is calculated based on the total θJA value, ambient, and junction
temperatures with the following equation.
Figure 12.

Total Power

3.2 Cyclone 10 LP EPE - Logic Worksheet
Each row in the Logic worksheet of the Early Power Estimator (EPE) spreadsheet
represents a separate design module.
Enter the following parameters for each design module:
•

Number of combinational adaptive look-up tables (ALUTs)

•

Number of flipflops

•

Clock frequency in MHz

•

Toggle percentage

•

Average fanout
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Figure 13.

Logic Worksheet of the EPE Spreadsheet

Table 8.

Logic Worksheet Information
Column Heading

Description

Module

Specify a name for each module of the design. This is an optional entry.

#LUTs

Enter the number of look-up tables (LUTs).
This is the “Combinational ALUTs” value from the Quartus Prime Compilation
Report Resource Usage Summary section.

#FFs

Enter the number of flipflops in the module.
This is the sum of “Register ALUTs” and “Dedicated logic registers” from the
Quartus Prime Compilation Report Resource Usage Summary section.
Clock routing power is calculated separately on the Clock worksheet of the EPE
spreadsheet.

Clock Freq (MHz)

Enter a clock frequency (in MHz). This value is limited by the maximum
frequency specification for the device family.
100 MHz with a 12.5% toggle means that each LUT or flipflop output toggles
12.5 million times per second (100 × 12.5%).

Toggle%

Enter the average percentage of logic toggling on each clock cycle. The toggle
percentage ranges from 0 to 100%. Typically, the toggle percentage is 12.5%,
which is the toggle percentage of a 16-bit counter. To ensure you do not
underestimate the toggle percentage, use a higher toggle percentage. Most logic
only toggles infrequently; therefore, toggle rates of less than 50% are more
realistic.
For example, a T-flipflop (TFF) with its input tied to VCC has a toggle rate of
100% because its output is changing logic states on every clock cycle. Refer to
the 4-Bit Counter Example.

Average Fanout

Enter the average number of blocks fed by the outputs of the LUTs and flipflops.

Thermal Power (W)–Routing

This shows the power dissipation due to estimated routing (in watts).
Routing power depends on placement and routing, which is a function of design
complexity. The values shown represent the routing power based on
experimentation of more than 100 designs.
For detailed analysis based on your design’s routing, use the Quartus Prime
Power Analyzer.

Thermal Power (W)–Block

This shows the power dissipation due to internal toggling of the ALMs (in watts).
Logic block power is a combination of the function implemented and the relative
toggle rates of the various inputs. The EPE spreadsheet uses an estimate based
on observed behavior across more than 100 real-world designs.
For accurate analysis based on your design’s exact synthesis, use the Quartus
Prime Power Analyzer.

Thermal Power (W)–Total

This shows the total power dissipation (in watts). The total power dissipation is
the sum of the routing and block power.

User Comments

Enter any comments. This is an optional entry.
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Figure 14.

4-Bit Counter Example
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The first TFF with the cout0 LSB output has a toggle rate of 100% because the signal
toggles on every clock cycle. The toggle rate for the second TFF with cout1 output is
50% because the signal only toggles on every two clock cycles. Consequently, the
toggle rate for the third TFF with cout2 output and fourth TFF with cout3 output are
25% and 12.5%, respectively. Therefore, the average toggle percentage for this 4-bit
counter is (100 + 50 + 25 + 12.5)/4 = 46.875%.
For more information about logic block configurations, refer to the Logic Array Blocks
and Adaptive Logic Modules section of the Cyclone 10 LP device handbook.

3.3 Cyclone 10 LP EPE - RAM Worksheet
Each row in the RAM worksheet of the Early Power Estimator (EPE) spreadsheet
represents a design module where the RAM blocks are the same type, have the same
data width, the same RAM depth (if applicable), the same RAM mode, and the same
port parameters. If some or all of the RAM blocks in your design have different
configurations, enter the information in different rows. For each design module, enter
the type of RAM implemented, the number of RAM blocks, and the RAM block mode.
Each row in the RAM worksheet of the EPE spreadsheet can also represent a logical
RAM module that can be physically implemented on more than one RAM block. The
EPE spreadsheet implements each logical RAM module with the minimum number of
physical RAM blocks, in the most power-efficient way possible, based on the width and
depth of the logical instance entered.
You must know how your RAM is implemented by the Quartus Prime Compiler when
you are selecting the RAM block mode. For example, if a ROM is implemented with two
ports, it is considered a true dual-port memory and not a ROM. Single-port and ROM
implementations only use Port A. Simple dual-port and true dual-port implementations
use Port A and Port B.
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Figure 15.

RAM Worksheet of the EPE Spreadsheet

Table 9.

RAM Worksheet Information
Column Heading

Description

Module

Enter a name for the RAM module in this column. This is an optional value.

RAM Type

Select the implemented RAM type.
You can find the RAM type in the Type column of the Quartus Prime Compilation
Report. In the Compilation Report, select Fitter and click Resource Section.
Click RAM Summary.

#RAM Blocks

Enter the number of RAM blocks in the module that use the same type and mode
and have the same parameter for each port. The parameters for each port are:
• Clock frequency in MHz
• Percentage of time the RAM is enabled
• Percentage of time the port is writing as opposed to reading
You can find the number of RAM blocks in either the memory logic array block
(MLAB) or M9K column of the Quartus Prime Compilation Report. In the
Compilation Report, select Fitter and click Resource Section. Click RAM
Summary.

Data Width

Enter the width of the data for the RAM block. This value is limited based on the
RAM type. You can find the width of the RAM block in the Port A Width or the Port
B Width column of the Quartus Prime Compilation Report. In the Compilation
Report, select Fitter and click Resource Section. Click RAM Summary.
For RAM blocks that have different widths for Port A and Port B, use the larger of
the two widths.

RAM Depth

Enter the depth of the RAM block in number of words.
You can find the depth of the RAM block in the Port A Depth or the Port B Depth
column of the Quartus Prime Compilation Report. In the Compilation Report,
select Fitter and click Resource Section. Click RAM Summary.

RAM Mode

Select from the following modes:
• Single-Port
• Simple Dual-Port
• True Dual-Port
• ROM
The mode is based on how the Quartus Prime Compiler implements the RAM. If
you are unsure how your memory module is implemented, Intel recommends
compiling a test case in the required configuration in the Quartus Prime software.
You can find the RAM mode in the Mode column of the Quartus Prime
Compilation Report. In the Compilation Report, select Fitter and click
Resource Section. Click RAM Summary.
A single-port RAM has one port with a read and write control signal. A simple
dual-port RAM has one read port and one write port. A true dual-port RAM has
two ports, each with a read and write control signal. ROMs are read-only singleport RAMs.

Port A–Clock Freq (MHz)

Enter the average percentage of time the input clock enable for Port A is active,
regardless of the activity on the RAM data and address inputs. The enable
percentage ranges from 0 to 100%. The default value is 25%.
continued...
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Column Heading

Description
RAM power is primarily consumed when a clock event occurs. Using a clock
enable signal to disable a port when no read or write operation is occurring can
result in significant power savings.

Port A–Enable

Enter the average percentage of time the input clock enable for Port A is active,
regardless of the activity on the RAM data and address inputs. The enable
percentage ranges from 0 to 100%.
RAM power is primarily consumed when a clock event occurs. Using a clockenable signal to disable a port when no read or write operation is occurring can
result in significant power savings.

Port A–Write %

Enter the average percentage of time Port A of the RAM block is in write mode
versus read mode. For simple dual-port (1R/1W) RAMs, the write Port A is
inactive when not executing a write operation. For single-port and dual-port
RAMs, Port A reads when it is not written to. This field is ignored for RAMs in
ROM mode.
This value must be a percentage number between 0 and 100%. The default
value is 50%.

Port B–Clock Freq (MHz)

Enter the clock frequency for Port B of the RAM blocks in MHz. This value is
limited by the maximum frequency specification for the RAM type and device
family. Port B is ignored for RAM blocks in ROM or single-port mode or when the
chosen RAM type is MLAB.

Port B–Enable %

Enter the average percentage of time the input clock enable for Port B is active,
regardless of the activity on the RAM data and address inputs. The enable
percentage ranges from 0 to 100%.
RAM power is primarily consumed when a clock event occurs. Using a clockenable signal to disable a port when no read or write operation is occurring can
result in significant power savings.

Port B–R/W %

For RAM blocks in true dual-port mode, enter the average percentage of time
Port B of the RAM block is in write mode versus read mode. For RAM blocks in
simple dual-port mode, enter the percentage of time Port B of the RAM block is
reading. You cannot write to Port B in simple dual-port mode. Port B is ignored
for RAM blocks in ROM or single-port mode or when the chosen RAM type is
MLAB.
This value must be a percentage number between 0 and 100%. The default
value is 50%.

Toggle%

The average percentage for how often each block output signal changes value on
each clock cycle is multiplied by the clock frequency and enables the percentage
to determine the number of transitions per second. This only affects routing
power.
50% corresponds to a randomly changing signal. A random signal changes states
only half the time.

Suggested FF Usage

Displays the number of flipflops that you require to make the MLAB function
correctly. The MLAB power in the RAM worksheet does not include the power of
the flipflops.
If you enter the device resources manually, add the suggested number of
flipflops to the Logic worksheet using the same clock frequency.
If you have imported the device resources from the EPE file, no action is
required.
This field is only valid when the chosen RAM type is MLAB.

Thermal Power (W)–Routing

This shows the power dissipation due to estimated routing (in watts).
Routing power depends on placement and routing, which is a function of design
complexity. The values shown represent the routing power based on
experimentation of more than 100 designs.
For detailed analysis based on your design’s routing, use the Quartus Prime
Power Analyzer. This value is calculated automatically.

Thermal Power (W)–Block

This shows the power dissipation due to internal toggling of the RAM (in watts).
continued...
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Column Heading

Description
For accurate analysis based on your design’s exact RAM modes, use the Quartus
Prime Power Analyzer. This value is calculated automatically.

Thermal Power (W)–Total

This shows the estimated power in watts, based on your inputs. It is the total
power consumed by the RAM blocks and is equal to the routing power and block
power. This value is calculated automatically.

User Comments

Enter any comments. This is an optional entry.

For more information about RAM block configurations, refer to the Memory Blocks
section of the Cyclone 10 LP device handbook.

3.4 Cyclone 10 LP EPE - DSP Worksheet
Each row in the DSP section represents a DSP design module where all instances of
the module have the same configuration, clock frequency, toggle percentage, and
register usage. If some (or all) DSP or multiplier instances have different
configurations, you must enter the information in different rows.
Specify the following information for each DSP or multiplier module:
•

Configuration

•

Number of instances

•

Clock frequency (in MHz)

•

Toggle percentage of the data outputs

•

Inputs and outputs that are registered or not

•

Module pipelined or not

•

Coefficient

•

Registered Stages

Figure 16.

DSP Worksheet of the EPE Spreadsheet

Table 10.

DSP Worksheet Information
Column Heading

Description

Module

Enter a name for the DSP module in this column. This is an optional value.

Configuration

Select the DSP block configuration for the module.

# of Instances

Enter the number of DSP block instances that have the same configuration, clock
frequency, toggle percentage, and register usage. This value is independent of
the number of dedicated DSP blocks you use.
For example, it is possible to use four 9 × 9 simple multipliers that are
implemented in the same DSP block in the FPGA devices. In this case, the
number of instances would be four.
continued...
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Column Heading

Description
To determine the maximum number of instances you can fit in the device for any
particular mode, follow these steps:
1. Open the “DSP Blocks”, “Variable Precision DSP Blocks”, or “Embedded
Multipliers” chapter of the respective device handbook.
2. In the “Number of DSP Blocks” table, take the maximum number of DSP
blocks available in the device for the mode of operation.
3. Divide the maximum number by the “# of Mults” for that mode of operation
from the “DSP Block Operation Modes” table.
4. Use the resulting value for the “# of Instances” in the EPE spreadsheet.

Clock Freq (MHz)

Enter the clock frequency for the module in MHz. This value is limited by the
maximum frequency specification for the device family.

Toggle %

Enter the average percentage of DSP data outputs toggling on each clock cycle.
The toggle percentage ranges from 0 to 50%. The default value is 12.5%. For a
more conservative power estimate, use a higher toggle percentage.
In addition, 50% corresponds to a randomly changing signal (because half the
time the signal changes from a 0-to-0 or 1-to-1). This is considered the highest
meaningful toggle rate for a DSP block.

Reg Inputs?

Select whether the inputs of the dedicated DSP block or multiplier block are
registered using the dedicated input registers. If you use the dedicated input
registers in the DSP or multiplier block, select Yes. If the inputs are unregistered
or registered using registers in the ALMs or the look-up table (LUTs), select No.

Reg Outputs?

Select whether the outputs of the dedicated DSP block or multiplier block are
registered using the dedicated input registers. If you use the dedicated output
registers in the DSP or multiplier block, select Yes. If the inputs are unregistered
or registered using registers in ALMs or LUTs, select No.

Pipelined?

Select whether or not the dedicated DSP block is pipelined. Pipelined DSPs are
not available in Cyclone 10 LP devices.

Thermal Power (W)–Routing

This shows the power dissipation due to estimated routing (in watts).
Routing power depends on placement and routing, which is a function of design
complexity. The values shown represent the routing power based on
experimentation of more than 100 designs.

Thermal Power (W)–Block

This shows the estimated power consumed by the DSP blocks (in watts). This
value is automatically calculated.

Thermal Power (W)–Total

This shows the estimated power (in watts), based on your inputs. It is the total
power consumed by the DSP blocks and is equal to the routing power and block
power. This value is automatically calculated.

User Comments

Enter any comments. This is an optional entry.

For more information about DSP block configurations, refer to DSP Blocks, Variable
Precision DSP Blocks, or Embedded Multipliers sections of the Cyclone 10 LP device
handbook.

3.5 Cyclone 10 LP EPE - I/O Worksheet
Each row in the I/O worksheet represents a design module where the I/O pins have
the same I/O standard, input termination, current strength or output termination,
data rate, clock frequency, output enable static probability, and capacitive load.
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Enter the following parameters for each design module:
•

I/O standard

•

Input termination

•

Current strength/Output termination

•

Slew rate

•

Differential output voltage (VOD) setting

•

Pre-emphasis setting

•

Number of input, output, and bidirectional pins

•

I/O data rate

•

Clock frequency (fMAX) (in MHz)

•

Average pin toggle percentage

•

Output enable static probability

•

Capacitance of the load

For the EPE spreadsheet version 11.0 onwards, Off Chip Power (W) information is
added into the I/O worksheet.
Figure 17.

I/O Worksheet of the EPE Spreadsheet

When using the EPE spreadsheet, it is assumed you are using external termination
resistors when you design with I/O standards that recommend termination resistors
(SSTL and high-speed transceiver logic [HSTL]). If your design does not use external
termination resistors, choose the LVTTL/LVCMOS I/O standard with the same VCCIO
and similar current strength as the terminated I/O standard. For example, if you are
using the SSTL-2 Class II I/O standard with a 16 mA current strength, you must select
2.5 V as the I/O standard and 16 mA as the current strength in the EPE spreadsheet.
To use on-chip termination (OCT), select the Current Strength/Output option in the
EPE spreadsheet.
The power reported for the I/O signals includes thermal and external I/O power. The
total thermal power is the sum of the thermal power consumed by the device from
each power rail, as shown in the following equation.
Total Thermal Power = Thermal PVCC + Thermal PIO
The following figure shows the I/O power consumption. The ICCIO power rail includes
both the thermal PIO and the external PIO.
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Figure 18.

I/O Power Representation

The VREF pins consume minimal current (typically less than 10 μA) and is negligible
when compared with the current consumed by the general purpose I/O (GPIO) pins;
therefore, the EPE spreadsheet does not include the current for VREF pins in the
calculations.
Table 11.

I/O Power Rail Information
Column Heading

Description

Power Rails

Power supply rails for the I/O pins.

Voltage (V)

The voltage applied to the specified power rail in Volts (V).

Current (A)

The current drawn from the specified power rail in Amps (A).

Table 12.

I/O Worksheet Information
Column Heading

Module

Description
Specify a name for the module in this column. This is an optional
value.

I/O Buffer Settings
I/O Standard

Select the I/O standard used for the input, output, or bidirectional
pins in this module from the drop-down list.
The calculated I/O power varies based on the I/O standard. For I/O
standards that recommend termination (SSTL and HSTL), the EPE
spreadsheet assumes you are using external termination resistors. If
you are not using external termination resistors, choose the LVTTL/
LVCMOS I/O standard with the same voltage and current strength as
the terminated I/O standard.
To view all the I/O standards in the drop-down list, use the scroll bar.

Input Termination

Select the input termination (on-chip parallel termination [RT OCT] or
on-chip differential termination [RD OCT]) setting implemented for
the input and bidirectional pins in this module.

Current Strength/ Output Termination

Select the current strength or output termination (on-chip serial
termination [RS OCT]) implemented for the output and bidirectional
pins in this module.
Current strength and output termination are mutually exclusive.
continued...
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Column Heading

Description

Slew Rate

Select the slew rate setting for the output and bidirectional pins in
this module. Using a lower slew rate setting helps to reduce
switching noise but may increase delay.

VOD Setting

Select the VOD for the output and bidirectional pins in this module. If
you use a lower voltage, it helps to reduce static power.

Pre-Emphasis Setting

Select the pre-emphasis setting for output and bidirectional pins in
this module. Disable the pre-emphasis will reduce dynamic power.

#Input Pins

Enter the number of input pins used in this module. Consider a
differential pin pair as one pin.

#Output Pins

Enter the number of output pins used in this module. Consider a
differential pin pair as one pin.

#Bidir Pins

Enter the number of bidirectional pins used in this module. When you
enable the output enable signal, the I/O pin is treated as an output.
When you disable the output enable signal, the I/O pin is treated as
an input.
An I/O configured as bidirectional but used only as an output
consumes more power than an I/O configured as output-only, due to
the toggling of the input buffer every time the output buffer toggles
(they share a common pin).

Data Rate

Select either SDR or DDR as the I/O data rate.
This indicates whether the I/O value is updated once (single data
rate [SDR]) or twice (double data rate [DDR]) in a clock cycle. If the
data rate of the pin is DDR, it is possible to set the data rate to SDR
and double the toggle percentage. The Quartus Prime software uses
this method to output information.

Clock Freq (MHz)

Enter the clock frequency (in MHz). This value is limited by the
maximum frequency specification for the device family.
100 MHz with a 12.5% toggle means that each I/O pin toggles 12.5
million times per second (100 × 12.5%).

Toggle %

Enter the average percentage of input, output, and bidirectional pins
toggling on each clock cycle. For input pins used as clocks, the toggle
percentage ranges from 0 to 200% because clocks toggle at twice
the frequency.
If the pins use DDR circuitry, you can set the data rate to SDR and
double the toggle percentage. The Quartus Prime software uses this
method to output information. Typically, the toggle percentage is
12.5%. To be more conservative, you can use a higher toggle
percentage.

OE %

Enter the average percentage of time that the:
• Output I/O pins are enabled.
• Bidirectional I/O pins are outputs and enabled.
During the remaining time the:
• Output I/O pins are tristated.
• Bidirectional I/O pins are inputs.
The value you enter must be a percentage between 0 and 100%.

Load (pF)

Enter the pin loading external to the chip (in pF).
This only applies to outputs and bidirectional pins. Pin and package
capacitance is already included in the I/O model. Therefore, only
include the off-chip capacitance in the Load parameter.

Thermal Power (W)–Routing

This shows the power dissipation due to estimated routing (in watts).
Routing power depends on placement-and-routing information, which
is a function of design complexity. The values shown represent the
routing power based on experimentation of more than 100 designs.
For detailed analysis based on your design’s routing, use the Quartus
Prime Power Analyzer. This value is automatically calculated.
continued...
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Column Heading

Description

Thermal Power (W)–Block

This shows the power dissipation due to internal and load toggling of
the I/O (in watts).
For accurate analysis based on your design’s exact I/O configuration,
use the Quartus Prime Power Analyzer. This value is automatically
calculated.

Thermal Power (W)–Total

This shows the total power dissipation (in watts). The total power
dissipation is the sum of the routing and block power. This value is
automatically calculated.

Supply Current (A)–ICC

This shows the current drawn from the VCC power rail and powers the
internal digital circuitry. This value is automatically calculated.

Supply Current (A)–ICCIO

This shows the current drawn from the VCCIO power rail. Some of this
current may be drawn into off-chip termination resistors. This value
is automatically calculated.

User Comments

Enter any comments. This is an optional entry.

For more information about I/O standard termination schemes, refer to the I/O
Features section of the Cyclone 10 LP device handbook.

3.6 Cyclone 10 LP EPE - PLL Worksheet
Cyclone 10 LP devices feature PLLs for general use. Each row in the PLL worksheet of
the Early Power Estimator (EPE) spreadsheet represents one or more PLLs in the
device. Enter the maximum output frequency and the VCO frequency for each PLL.
You must also specify whether each PLL is an LVDS, fractional, left/right, or top/
bottom PLL.
When a PLL drives source synchronous SERDES hardware, it is referred to as an LVDS
PLL. If you are using dedicated transmitters or receivers and are using an LVDS PLL to
implement serialization or deserialization, specify an LVDS PLL and enter the power
information in the PLL worksheet. LVDS PLLs drive LVDS clock trees and dynamic
phase alignment (DPA) buses at the voltage-controlled oscillator (VCO) frequency. If
an LVDS PLL drives the LVDS hardware only, enter the appropriate VCO frequency and
specify an output frequency of 0 MHz. If the LVDS PLL also drives a clock to a pin or
to the core, specify that clock frequency as the output frequency.
Figure 19.

PLL Worksheet of the EPE Spreadsheet
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Table 13.

PLL Worksheet Information
Column Heading

Description

Module

Specify a name for the PLL in this column. This is an optional value.

# PLL Blocks

Enter the number of PLL blocks with the same specific output frequency and VCO
frequency combination.

Output Freq (MHz)

Enter the maximum output frequency of the PLL (in MHz). The maximum output
frequency is reported in the Output Frequency column of the Quartus II
Compilation Report. In the Compilation Report, select Fitter and click
Resource Section. Select PLL Usage and click Output Frequency.

VCO Freq (MHz)

Enter the internal VCO operating frequency for this module. The LVDS PLL drives
the LVDS clock tree and DPA bus at this frequency. This frequency includes the
VCO post scale counter.

VCO Freq (MHz)

Enter the internal VCO operating frequency for general purpose PLL.

Total Power (W)

Shows the estimated combined power for VCCA and VCCD (in watts), based on the
maximum output frequency and the VCO frequency you entered. This value is
automatically calculated.

User Comments

Enter any comments. This is an optional entry.

For more information about the PLLs of the supported device families, refer to the
Clock Networks and PLLs section of the Cyclone 10 LP device handbook.

3.7 Cyclone 10 LP EPE - Clock Worksheet
Intel FPGA devices support global, regional, or periphery clock networks. The Early
Power Estimator (EPE) spreadsheet does not distinguish between global or regional
clocks because the difference in power is not significant.
Each row in the Clock worksheet of the EPE spreadsheet represents a clock network or
a separate clock domain. Enter the following parameters for each design module:

Figure 20.

•

Clock frequency (in MHz)

•

Total fanout for each clock network used

•

Global clock enable percentage

•

Local clock enable percentage

Clock Worksheet of the EPE Spreadsheet
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Table 14.

Clock Worksheet Information
Column Heading

Description

Domain

Specify a name for the clock network in this column. This is an optional value.

Clock Freq (MHz)

Enter the frequency of the clock domain. This value is limited by the maximum
frequency specification for the device family.

Total Fanout

Enter the total number of flipflops and RAM, DSP, and I/O blocks fed by this
clock. The number of resources driven by every global clock and regional clock
signal is reported in the Fan-out column of the Quartus II Compilation Report. In
the Compilation Report, select Fitter and click Resources Section. Select
Global and Other Fast Signals and click Fan-out.

Global Enable %

Enter the average percentage of time that the entire clock tree is enabled. Each
global clock buffer has an enable signal that you can use to dynamically shut
down the entire clock tree.

Local Enable %

Enter the average percentage of time that clock enable is high for destination
flipflops.
Local clock enables for flipflops in ALMs are promoted to LAB-wide signals. When
a given flipflop is disabled, the LAB-wide is clock disabled, cutting clock power
and the power for down-stream logic. This worksheet models only the impact on
clock tree power.

Total Power (W)

This is the total power dissipation due to clock distribution (in watts). This value
is automatically calculated.

User Comments

Enter any comments. This is an optional entry.

For more information about clock networks, refer to the Clock Networks and PLLs
section of the Cyclone 10 LP device handbook.

3.8 Cyclone 10 LP EPE - Report Worksheet
The Report worksheet shows all the information and power estimation results from the
Early Power Estimator (EPE) spreadsheet.
You can find the power supply recommendations in the Power Supply Current (A)
section, which describes all the power supply requirements for the device that your
design uses in the Min Current Requirement (A) and the User Mode Current
Requirement (A) columns.

3.8.1 Static Power and Dynamic Current per Voltage Rail
The Report worksheet shows all the information and power estimation results from the
Early Power Estimator (EPE) spreadsheet. You can find the power supply
recommendations in the Power Supply Current (A) section, which describes all the
power supply requirements for the device that your design uses in the Min Current
Requirement (A) and the User Mode Current Requirement (A) columns.
Figure 21.

Separate Static and Dynamic Current in Power Supply Current Section
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3.8.2 Power Up Current
In some device families, the power up current can be larger than the dynamic current
required in the I/O worksheet. For example, the ICCPD value on the I/O worksheet can
be different than the Minimum current requirement for ICCPD on the Report worksheet.
Intel provides the minimum current required for the VCCPD power rail for each voltage
supply used, but is not dependent on how many banks use that voltage supply.
To estimate the power up current, use the Report worksheet and compare the
minimum current requirement with user mode current requirement.

3.8.3 Power Breakout for Multiple Voltage Supplies
For VCCIO and VCCPD, the minimum current requirement reported for ICCIO and ICCPD
respectively has the same value for each voltage rail used in your design.
These values are based on all I/O pins in the device being powered by the same
voltage rail, thus the minimum current requirement is repeated for each unique
voltage rail used by VCCIO and VCCPD.
To better estimate the minimum current requirements for ICCIO and ICCPD based on
your device and design usage, you can use the following equations:
•

[(Number of I/O pins powered by VCCIO voltage) / (number of total I/O pins in the
device)] × (Minimum supply current) × (1.10)

•

[(Number of I/O pins powered by VCCPD voltage) / (number of total I/O pins in the
device)] × (Minimum supply current) × (1.10)

Repeat the formula for each VCCIO voltage and VCCPD voltage used in your design. The
number of I/O pins powered by VCCIO and VCCPD voltage represents the count of both
used and unused I/O pins in I/O banks powered by a particular voltage. The minimum
supply current is the value provided in the power estimation tools for ICCIO and ICCPD.
The 1.10 scaling factor is provided as additional guardband and must be included for
your power estimation.

3.8.4 Power Regulator Settings
Regulator groups consist of rails that can be combined and supplied by a single
regulator. A manual entry here can move a rail from one group to another or create a
new group. This may be necessary to correct grouping errors that may occur.

3.9 Cyclone 10 LP EPE - Enpirion Worksheet
Enpirion power devices are available to satisfy the power requirements for the power
rails on Intel FPGA devices. Power devices are selected based on load current, input
and output voltages, and power-delivery configuration.
Each row in the Regulator Selection table represents the power solution for a single
power group. The power groups are created by combining rails that can be allowably
supplied from the same source. Enpirion device selection is enabled when the Main
worksheet for the Maximum Power Characteristics and the Regulator Group section of
the Report worksheet are set up correctly with no grouping errors.
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In the following figure, a 12-V off-line regulator supplies input power for Groups 1 and
5. The 3-V regulator supplying Group 5 also acts as an intermediate bus supplying
input power for Groups 2, 3, and 4.
Figure 22.

Enpirion Worksheet of the Early Power Estimator Spreadsheet

Table 15.

Enpirion Worksheet Information
Column Heading

Description

Group

Compatible rails are combined in order to minimize the
number of regulators required. For additional information,
refer to the Report worksheet. See also Grouping Errors on
the Main worksheet.

Regulator Input Voltage (V)

Enter the input voltage here. The output voltage will be
derived from this voltage. This field is filled automatically
when non-zero Parent Group is specified.

Load Current Margin

Margin can be added to account for component variability. It
is recommended to retain the default 30% to assure the
thermal capability of the solution over the full range of
device variation and operating conditions. However, in
certain cases when characteristics and conditions are fully
defined, reducing the margin may lead to a more costeffective solution. Exercise caution when changing these
values.

Parent Group

If one of the group voltages is to be used as an
intermediate bus voltage, enter the group number here.

Regulator Type

In some cases, a linear regulator (LDO) may be a good
choice to supply one of the group voltages. The efficiency of
an LDO is the ratio of output voltage to input voltage. In the
figure, Group 2 can be efficiently supplied by an LDO. If
desired, select Linear in the row for Group 2.

POK

Select Yes to select a regulator with a Power OK (POK)
output to assist with sequencing.

Suggested Enpirion Part

Suggested Enpirion part is automatically populated with the
part number of the device that most closely matches the
Load Current (A), Regulator Type and POK selections.
The dropdown can be used to optionally select devices with
equivalent or higher current capabilities.

Pin Compatible Parts

Pin compatible parts are devices with equivalent or higher
current capabilities that can be placed on the same PCB
footprint as the Suggested Enpirion Part. Additional
components or changes to component values may be
required when using a pin compatible part.

3.10 Document Revision History
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Table 16.

Document Revision History
Date

May 2017

Version
2017.05.08

Changes
•

Initial release.
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4 Factors Affecting the Accuracy of the Early Power
Estimator for Intel Cyclone 10 LP
Many factors can affect the estimated values displayed in the Early Power Estimator
spreadsheet. In particular, the input parameters entered concerning toggle rates,
airflow, temperature, and heat sinks must be accurate to ensure that the system is
modeled correctly in the EPE spreadsheet.

4.1 Toggle Rate
The toggle rates specified in the Early Power Estimator (EPE) spreadsheet can have a
large impact on the dynamic power consumption displayed. To obtain an accurate
estimate, you must provide toggle rates that are realistic. Determining realistic toggle
rates requires knowing what kind of input the FPGA is receiving and how often it
toggles.
To get an accurate estimate if the design is not complete, isolate the separate modules
in the design by function and estimate the resource usage along with the toggle rates
of the resources. The easiest way to accomplish this is to leverage previous designs to
estimate the toggle rates for modules with similar function.
The input data in the following figure is encoded for data transmission and has a
roughly 50% toggle rate.
Figure 23.

Decoder and Encoder Block Diagram
Mod Input
Data

Decoder

RAM

Filter

Modulator

Encoder

In this case, you must estimate the following:
•

Data toggle rate

•

Mod input toggle rate

•

Resource estimate for the Decoder module, RAM, Filter, Modulator, and Encoder

•

Toggle rate for the Decoder module, RAM, Filter, Modulator, and Encoder

You can generate these estimates in many ways. If you used similar modules in the
past with data inputs of roughly the same toggle rate, you can leverage that
information. If MATLAB simulations are available for some blocks, you can obtain the
toggle rate information. If the HDL is available for some of the modules, you can
simulate them.
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If the HDL is complete, the best way to determine toggle rate is to simulate the
design. The accuracy of toggle rate estimates depends on the accuracy of the input
vectors. Therefore, determining whether or not the simulation coverage is high gives
you a good estimate of how accurate the toggle rate information is.
The Quartus Prime software can determine toggle rates of each resource used in the
design if you provide information from simulation tools. Designs can be simulated in
many different tools and the information provided to the Quartus Prime software
through a Signal Activity File (.saf). The Quartus Prime Power Analyzer provides the
most accurate power estimate. You can import the comma-separated value file (.csv)
from the Quartus Prime software into the EPE spreadsheet for estimating power after
your design is complete.

4.2 Airflow
It is often difficult to place the device adjacent to the fan providing the airflow. The
path of the airflow might traverse a length on the board before reaching the device,
thus diminishing the actual airflow the device receives. The following figure shows a
fan that is placed at the end of the board. The airflow at the FPGA is weaker than the
airflow at the fan.
Figure 24.

Airflow and FPGA Position

FAN
FPGA
You must also consider blocked airflow. The following figure shows a device blocking
the airflow from the FPGA, significantly reducing the airflow seen at the FPGA. The
airflow from the fan also has to cool board components and other devices before
reaching the FPGA.
Figure 25.

Airflow with Component and FPGA Positions

FAN
Device

FPGA

If you are using a custom heat sink, you do not need to enter the airflow directly into
the EPE spreadsheet but it is required to enter the θSA value for the heat sink with the
knowledge of what the airflow is at the device. Most heat sinks have fins located
above the heat sink to facilitate airflow. The following figure shows the FPGA with a
heat sink.
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Figure 26.

Airflow and Heat Sinks

FAN
Heat Sink Fins
Heat Sink

FPGA

When placing the heat sink on the FPGA, the direction of the fins must correspond
with the direction of the airflow. A top view shows the correct orientation of the fins.
Figure 27.

Heat Sink (Top View)

FAN

Heat Sink Fins

These considerations can influence the airflow at the device. When entering
information into the EPE spreadsheet, you have to consider these implications to get
an accurate airflow value at the FPGA.

4.3 Temperature
To calculate the thermal information of the device correctly, you must enter the
ambient air temperature for the device into the Early Power Estimator (EPE)
spreadsheet. Ambient temperature refers to the temperature of the air around the
device, which is usually higher than the ambient temperature outside of the system.
For an accurate representation of ambient temperature for the device, you must
measure the temperature as close to the device as possible with a thermocouple
device.
If you enter incorrect ambient air temperature, you can drastically alter the power
estimates in the EPE spreadsheet. The following figure shows a simple system with the
FPGA housed in a box. In this case, the temperature is very different at each of the
numbered locations.
Figure 28.

Temperature Variances

4

2
FAN

3
FPGA
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For example, location 3 is where the ambient temperature pertaining to the device
should be obtained for input into the EPE spreadsheet. Locations 1 and 2 are cooler
than location 3 and location 4 is likely close to 25 °C if the ambient temperature
outside the box is 25 °C. Temperatures close to devices in a system are often in the
neighborhood of 50–60 °C but the values can vary significantly. To obtain accurate
power estimates from the EPE spreadsheet, you must get a realistic estimate of the
ambient temperature near the FPGA device.

4.4 Heat Sink
The following equations show how to determine power when using a heat sink.
Figure 29.

Total Power

Figure 30.

Junction–to–Ambient Thermal Resistance

θJA TOP = θJC+ θCS + θSA
You can obtain the θJC value that is specific to the FPGA from the data sheet. The θCS
value refers to the material that binds the heat sink to the FPGA and is approximated
to be 0.1 °C/W. You can obtain the θSA value from the manufacturer of the heat sink.
Ensure that you obtain this value for the right conditions for the FPGA which include
analyzing the correct heat sink information at the appropriate airflow at the device.
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